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Overview 
YuniquePLM offers an updated Adobe Illustrator Plugin available for download from the Adobe Add-on store.   
The new AI plugin is compatible with Adobe Illustrator CC versions 2015.3 (20.0.0) or 2017 (21.0.0) and 
YuniquePLM version V7.0.0 to V7.1.0. Artboards are ONLY compatible with YPLM V7.1. This version does not 
support earlier versions of Illustrator CS6, CS5 or earlier. A Creative Cloud installation is required to proceed.  
Note: The YuniquePLM Design Suite 5.08 is ONLY compatible with YuniquePLM V7.0, 7.0.3, and 7.0.4.  
 
Follow the steps in this document to ensure your files are accessible via the Creative Cloud, as well as installing 
the Adobe Illustrator application and plugin.  

Creative Cloud Preferences 
It is important to ensure Adobe’s sync and notification options are enabled before proceeding. The Adobe 
Sync option ensures your files and folders are available from the Creative Cloud, while also ensuring that the 
user receives Adobe’s notifications after installing an Add-on.  

1. Select the Creative Cloud desktop icon, located in the Windows taskbar or the Apple menu as shown 
below. The Creative Cloud application opens to reveal a list of available software. 
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2. Click the Settings icon to open the Settings menu, then select Preferences. 

 
3. Select the General tab, if not already selected and ensure the Show Notifications option is checked. 
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4. Select the Creative Cloud tab. 
5. Select Files, then make sure the Sync On/Off feature is On.  

 
Creative Cloud is now available to sync your files and libraries including the Adobe Plugin.  
 
 

  

Keep In Mind! 

Adobe’s Creative Cloud may take 
some time to sync your files and 
plugins.  Once the files begin to 

sync, the Creative Cloud will 
provide a pop-up notification.  
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Install the Adobe Illustrator Application 
The Adobe Illustrator application is required.  Having multiple installations or versions of the same application 
is acceptable.  Keep in mind, the AI plugin is only compatible with Adobe Illustrator versions 2015.3 (20.0.0) 
and 2017 (21.0.0).  
 
If you do not have the application installed, navigate to the Creative Cloud application as shown in Step 1 of 
the Syncing the Adobe Add-ons section above.  

1. Select the Apps link.   
2. Scroll down to Illustrator and select Install. A list opens with a selection of various Illustrator versions.   
3. Select a CC version (2015.3 or 2017) to begin downloading. 
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Installing the Adobe Illustrator Plugin 
1. Click the following link https://creative.adobe.com/addons/products/18123#.WR7n5BPyvfA to directly 

open the YuniquePLM plugin or also use the search field to locate the YuniquePLM Design Suite add-
on. Then click on the YuniquePLM Design Suite title to open its product information page.   

 
2. Press the Free button under YuniquePLM Design Suite to install the add-on.  

 
3. An End-User License Agreement appears in a separate window.  Press the Accept and Continue button. 
4. A Creative Cloud notification appears confirming the add-ons installation.  

  

https://creative.adobe.com/addons/products/18123%23.WR7n5BPyvfA
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5. A secondary window opens confirming the add-on, while also offering the user a chance to install the 

Creative Cloud App, which should already be pre-installed.  
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Open the Adobe Illustrator App 
1. Open Adobe Illustrator either via the Creative Cloud app or from your computer’s menu. 

2. Open a new or existing Illustrator file. 
3. The YuniquePLM plugin may show up in two different locations within the Window Menu. Select one 

or more plugins to open and dock. 
a. Click the Window menu, then Extensions and finally select a YuniquePLM plugin.  

 
b. Click the Window menu, then scroll down and choose one of the YuniquePLM plugins.  

 
**Please note: The YuniquePLM extension will not appear in the list if Adobe Illustrator was open during 
the installation process. Users experiencing this issue are required to re-launch the application to see the 
newly installed extension. If the plugin does not appear in this step, refer to the Troubleshooting section of 
this document. 
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4. The YuniquePLM plugin opens.  Select the Settings icon to enter the connection settings of your PLM 
instance.  

   
 
Note: You need to enter the relevant connection information and credentials from the v7.0.X 

YuniquePLM application instance supplied by your system administrator. The Server, API, and PLM 

Instances are found within the Admin>WS Clients and Tools area of YuniquePLM.  

 

  

Tip! 

Leave this feature 
unchecked so the 

thumbnail is saved to 
the server, or it will be 

saved on the user’s 
machine.  
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5. Enter your YuniquePLM username and password to login to the plugin. Logging into one plugin 
automatically logs the user into all plugins, provided the user has permission for those areas in 
YuniquePLM. 

          
 

6. After logging in, each plugin can be docked onto Adobe Illustrator’s workspace. Simply click and drag a 

plugin into the desired dock area highlighted in blue. For more information regarding customizing the 

workspace, refer to Adobe Illustrator’s help section.  

 

The YuniquePLM plugin is now ready to use with Adobe Illustrator.  
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Tip! 

Press the Panel menu to 
quickly access additional 
ptions. Select Refresh to 
display new images from 

the Image Folder. 
 
 

Use the bottom icons to 
create a new color folder, 

view a color palette or 
edit the selected color 

palette.  
 
 

Using the Plugin 
The YuniquePLM plugin consist of the following areas: Colors, Images, and Styles.   Artboards, which is 
available to users of V7.1 or later, only works with the Adobe Plugin Image area.  Select a category to jump 
directly to its section within this document. 

 

Colors 
1. Select the Colors plugin tab to view a list of existing Color Palettes within the Color Folder.  
2. Choose a color palette to view and edit its color chips by clicking on the pencil icon located on the 

right-hand side. 
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3. A new window opens with options for Palette Type, Character, Palette Name, and Active. Enter a 
different name and select a different palette type or character from their drop-down menu. Select 
whether this palette should be active. Please note the fields that appear throughout the plugin might 
differ based on the configurations within the environment. 

4. Once finished, click Save. To disregard changes made and return to the list of color palettes, select 
Back. 

 
5. Within the Color Folder, double-click a Color Palette to view all of its colors. 
6. Colors within the palette may be searched using the search fields or Advanced Search options at the 

top of the window. To return to the Color Palettes list view, click the Back button. 

 
  

Tip! 

 

 

Pressing the Goto button opens a browser 
to the selected color palette in YuniquePLM. 

Use the bottom icons to 
delete a selected Color Chip, 
create a new color chip, edit 
a selected color chip, add to 
swatch, set the stroke color, 
or set the fill color directly 

from the YuniquePLM plugin.  
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7. Double-click a color to open up a new window which contains specific information associated with the 
color. Here, changes may be made to the Character, Color Code, Color Source, Color Name, Color Class, 
Status and Value (both RGB and Hex value). Click Save to keep your modifications. 

 
 

8. The user may also change the current color by clicking the color chip preview thumbnail to launch the 
Color Picker window. Here users may choose a color by clicking within the colored area or changing the 
values associated with the color. Once finished, click OK to keep the changes or Cancel to disregard any 
changes made. Press Back twice to return to the color palette list. 
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9. Click the add new icon, at the bottom right corner of the page, to create a new color folder. 

 
10. A new window opens. Select the appropriate Palette Type, Character, Palette Name and Active options 

from their respective drop-down menus. Once finished, click the Save button to create the Palette or 
click the Cancel button to disregard. 

  
 

11. The newly created Color Palette opens with an empty list. Add new colors by selecting the add new 
icon at the bottom right corner.  
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12. The Color Chip window opens allowing the users to enter a Character, Color Code, Color Name, Color 
Source, Color Class, Status, RGB Value or Hex Value. Users may also click on the color chip thumbnail 
preview to open the Color Picker window to select the desired color. Once finished, click the OK button 
to confirm, or click the Cancel button to close the window. 

 
 

13. After selecting a color, click Save to add it to the Color Palette in YuniquePLM, then press Back to 
return to the Color Palette page.  

14. The newly added color now appears in the specified Color Palette.  
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Images  
1. Select the Images plugin tab to view a list of images within the Image Folder. 
2. Search for the desired image in the YuniquePLM Image Folder using the search filters or advanced 

search options. A list of images, identified by their name and file type (AI, PNG, JPG, and PSD), appear 
for users to choose. AI’s files are currently the only editable format. 

3. Double-click an image to view its edit options. 

 
 

4. Users may edit header information within the data field entries. Click Save to keep the changes.  

 
 
 

Search area 

View and edit 
an image  

Create a 
new image 

Panel menu 

Tip! 

Pressing the Goto 
button opens a 
browser to the 

selected image in 
YuniquePLM. 
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5. If the image is an Illustrator file, double-click its thumbnail to open it in Adobe Illustrator. Apply any 
necessary changes to the image and click Save within the plugin.  

 
 

6. Click the History tab to view the image’s previous modifications.  

 
 

7. Click the Back button to return to the Image search results window. 

 

Tip! 

Double-click a previous 
version of the image to 

make it the primary 
selection.  

File Type: 
Illustrator 
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8. Users may select another image from this area or search for another using different image attributes. 
Double-click an image to view its attributes. 

 
 

9. This image appears in the left thumbnail column above the image previously edited.  Users may make 
changes to the image header information, or to the image itself if it is an Illustrator file. Press the Save 
button to keep any changes. 

 
  

Tip! 

Press the Session 
History button to 

return to the last edited 
image. 
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10. Remove an Image from the Session History by clicking the X button located at the top right corner. 
Please note this does not delete the image it just removes it from your session history. 

11. Press Back to return to the Image Folder main screen.  

 
12. To add a new image to the Image Folder, click the add new icon at the bottom right corner of the 

Image Folder main screen. 
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13. The user can open a blank file, open a file stored on the local drive or choose from a list of available 
documents that are already open. For example, the user would choose from a list of opened Illustrator 
files which were then imported into the system after making some modifications.  Select an option 
within the Source File drop-down menu then enter the image’s header information into the 
corresponding data fields.   

 
 

14. The newly added image appears in the upper left corner above images previously viewed or edited. 
Once finished, click the Save button.  

 
15. Press Back to return to the main image screen.  
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Styles 
1. Select the Styles plugin tab to view a list of available styles within the Style Folder. Scroll through the 

list of styles or use the search options to locate a Style.  
2. Double-click a style to open its editable view.  

 
 

3. The style opens and displays the front and back images, while also allowing the user to edit the header 
attributes. Make any necessary changes and press Save. 

 
 

Tip! 

Pressing the Goto 
button opens a 
browser to the 

selected style in 
YuniquePLM. 
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4. To create a new style, click the add new button, located at the bottom right corner. 

 
 

5. Select the appropriate style header related information within each drop-down, and click the Next 
button. 
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6. Complete the rest of the style header information on the next page, and click Save.   
**Please note: Required fields are marked with an asterisk. 

 
 

7. The new style contains no associated images.  The user may link their desired images using the Link 
Image button.  Use the image search window to locate the desired image.   
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8. Click to highlight an image then select the Link Image button.   

 
9. A pop-up window opens with the option to select whether you would like the image shown in the front 

or the back. Choose an option and press Ok. 

 

10. Click the Save button to keep the changes to the new style.  

 
 

 

 



Adobe Illustrator Plugin CC For PLM V7.0 And V7.1.x     

  24 

11. The new style resides in YuniquePLM.  Click the Goto… button to open a browser to the selected style 
in YuniquePLM. 
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Artboards  
Adobe allows multiple pages within a single illustrator file called Artboards. YuniquePLM offers users the 
ability to upload and use Artboards ONLY within the Adobe Plugin Image App. Artboards are ONLY compatible 
with YuniquePLM v7.1 and above.  
 
Users are unable to upload Artboards directly into YPLM. Mass linking of images to a style can ONLY occur 
within the v7.1 Adobe Plugin Style App. If you directly link an artboard image from the image folder to a style 
in YPLM, it will not automatically associate all of the related artboard files.  

1. Open Adobe Illustrator.  
2. Select the Window menu and press Artboards. 

 
 
3. The Artboards window opens.  Click the new button to add several artboards, then double-click to 
rename.  

  

Tip! 

Press New to add an artboard using the following example 
to match up the control panel artboard entries. 

 Front: Map to style header front image. 

 Back: Map to style header back image. 

 Design: Map to Design Images Text Image 
workflow page. 

 Technical: Map to Text Image workflow page 
Technical Details Sub Workflow. 

 FrontColorway: Map to Front Colorway for 
the corresponding Style Colorway. 

 BackColorway: Map to Back Colorway for the 
corresponding Style Colorway. 
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How to Link Images to Styles 
Each created Artboard will need to match up to a Control Panel Artboard entry.  

1. Within YuniquePLM, click the Home button and press the Control Panel link, within the left navigation 
bar.  

2. Expand the AI Plugin folder, then click Artboard Style Linking.  
3. This area contains pre-listed artboard entries which can be modified to fit the user’s preferred names 

or create a new entry.  
a. Click an entry to modify its configuration settings. 

 

b. Or press new to create and map your own entries.  
 

 

 

 

 

 

 

 

 

 

 

  

Tip! 

Make sure to select Yes for 
the Update With Last Version 

option to automatically 
update changes made from 

the artboard AI plugin to the 
YuniquePLM Style. 
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4. Use the following example to match up the artboard entries: 

 Front: Map to the style header front image. 

 Back: Map to the style header back image. 

 Design: Map to the Text Image workflow page Design Images Sub Workflow. 

 Technical: Map to the Text Image workflow page Technical Details Sub Workflow.  

 FrontColorway: Map to the Front Colorway for the corresponding Style Colorway.  

 BackColorway: Map to the Back Colorway for the corresponding Style Colorway.  
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Any artboard image can be assigned to a style, however, more than likely users will match the Front for the 
Front Image. Once it is linked, it automatically associates the other artboard images to the other workflow 
pages based on the control panel mapping.  

 

This will also create Text Image sub workflow pages based on the Control Panel mappings. 

 

  



Adobe Illustrator Plugin CC For PLM V7.0 And V7.1.x     

  29 

How to Link Colorway Images  
Double-click an Artboard entry to place the colorway color code directly after the name. Placing the color 
code within the name will map the entry to the appropriate colorway within YPLM. Example: 
FrontColorway18-1664 TCX (18-1664 TCX is the color code for the colorway being used on the BOM)  

 

Updating Artboard Images  
Once an artboard is assigned to a style, any updates made to the artboard images in the plugin, automatically 
updates back in the style. (This is dependent upon the control panel option, Update With Last Version is set to 
YES within new or pre-existing artboards). 

 

  

Tip! 

Make sure to select Yes for 
the Update With Last Version 

option to automatically 
update changes made from 

the artboard AI plugin to the 
YuniquePLM Style. 
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Removing an Artboard  
Removing an Artboard from Adobe Illustrator does not automatically remove it from a style within 
YuniquePLM.  
 

Tip for Text Image Artboards  
Placing a 1-10 etc. after the Artboard name, helps to identify each image and the page it will be mapped to in 
YuniquePLM. Example: Design1, Design2, Design3, Technical1, Technical2 etc. Keep in mind, the plugin will not 
allow a user to save duplicate Artboard names.  
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Troubleshooting the Adobe Illustrator Plugin 
Here are several steps to take if the Add-on/plugin does not appear within the Illustrator Extension section. 

1. Close the Adobe Illustrator application. The plugin will not install if the Adobe application is open. 
2. Sign out of the Creative Cloud app.  Select the Settings icon then press Preferences.  Select the General 

tab and press the Sign Out button.  

 
3. Login to the Creative Cloud app.  
4. Select the Settings icon then select Check for App Updates.  Ensure all updates have been completed. 

You may receive a popup notification stating the plugin was installed or click on the Home tab and look 
for a message: “You installed the add-on YuniquePLM Design Suite.” 
If this message is listed within the Home tab, then proceed to step 7, if not proceed to the next step. 

5. Return to your My Add-ons page https://creative.adobe.com/addons/my_addons then locate the 
plugin and select Remove. 

 
6. Re-install the plugin then select the Check for App Updates button stated within step 3. 
7. Reopen Adobe Illustrator and double check the Windows> Extension menu for the plugin.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

WINDOWS USERS! 
Are you receiving a message stating the add-on failed to install 
and it requires escalated privileges? Select the error message or 
the link below to view Adobe’s Support page for further 
information.  

 Adobe: Installation Failed, escalated privileges required 
Support page 

 
Locate the Adobe Creative Cloud app within your computer, then 
right-click the app icon and select Run as Admin. Click the 
following link for further assistance.  

 Run Adobe Applications as Administrator 
 
 

https://creative.adobe.com/addons/my_addons
https://helpx.adobe.com/extension-manager/using/extension-manager-errorcodereference.html#Installation%20failed%2C%20escalated%20privileges%20required?mv=product&mv2=accc
https://helpx.adobe.com/extension-manager/using/extension-manager-errorcodereference.html#Installation%20failed%2C%20escalated%20privileges%20required?mv=product&mv2=accc
https://helpx.adobe.com/x-productkb/global/run-program-administrator-windows-7.html
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Keep in mind, Adobe may take some time to sync 
your files and folders between the Creative Cloud 
and Illustrator applications. Adobe offers further 
troubleshooting assistance directly from the top of 
the My Add-ons page. Click the Trouble installing 
your Add-on? link and follow the recommended 
steps.   
 
If the above steps did not help, uninstall then 
reinstall the Adobe Illustrator and Creative Cloud 
applications, then proceed to follow the steps 
outlined in this manual.  
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